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INTRODUCTION

The MAGIC ISDN Telephone Hybrid system enables the forwarding of tele-
phone calls to analogue or optional digital AES/EBU audio-interfaces. Since
the system is based on a modular construction it is possible to expand it as de-
sired. The Basic system supports the simultaneous Hybrid-function up to
three or four callers, as well as call forwarding to a selected number.

In contrast to previous systems, great emphasis was put on using as little ex-
ternal wiring as possible. The system is able to realise functions such as digital
mixing of callers, digital Mix Minus, Echo-Cancelling, AGCs etc.

System configuration is carried using a simple Windows Application. The op-

eration can either be done by this software or by the optional MAGIC Hybrid
Keypad.
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SAFETY

Introduction

The unit described is designed to the latest technical parameters and complies
with all national and international safety requirements. It operates with a high
level of operational safety resulting from long development experience and
stringent quality control in our company.

In normal operation this equipment is safe.

There are, however, some potential sources of danger that cannot be com-
pletely eliminated.

This Operator Manual therefore contains basic safety instructions that must
be observed during system configuration and operation. The Operator Man-
ual must be read before the system is used and the current version of the doc-
ument must always be kept close to the equipment.

All safety instructions have a unifom appearance. This appearance is de-
scribed in detail in the following CHAPTER.

General safety requirements

In order to keep the technically unavoidable residual risk to a minimum it is
imperative to observe the following rules:

— Transport, storage and operation of the unit/system must be under the per-
missible conditions only.

— Installation, configuration and disassembly must be carried out only by
trained personnel and with reference to the respective documentation.

— The system must be operated by knowledgeable and authorised users only.
— The system must not be operated unless it is in good working order.

— Any conversions or alterations to the system or parts of the system (in-
cluding the software) must be carried out by qualified personnel from the
manufacturer or by expert personnel authorised by our company.

All alterations carried out by other persons lead to a complete exemption
from liability.

— The removal or disabling of safety measures, the correction of faults and
errors, and the maintenance of equipment must be carried out by specially
qualified personnel only.

— Non-system software is used at one’s own rsik. The uselinstallation of
non-system software can adversely affect the normal functioning of the
system.

— Only use tested and virus-free data carriers!
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Appereance of the safety instructions

All safety instructions include a signal word that classfies the danger and a
text block that contains descriptions of the type and cause of the danger, the
consequences of ignoring the safety instruction and the measures that can be
taken to minimise the danger. In some safety instructions, a warning symbol
is placed underneath the signal word (see TAB. 2, page 12)

Signal word  Type and cause of danger
Possible consequences of ignoring the safety instruction
Measures to minimise the danger.
Classification of danger
There are five classes of safety instructions: "danger”, "warning”, "caution”,
"notice” and "important”. The classification is shown in the following table.
TAB. 1 SIGNAL WORDS AND EFFECTS WHEN IGNORING THE SAFETY INSTRUCTIONS
result | Death Serious Minor Material damage? |Fault?
injury injury
] & 2} & ] & 2} & ] &
E 23 E (2|3 12 205 | |23 |2 % |2
S 172} i 172 S 172} i 172 S 72}
signalword \(| g |Z£ |8 |3 |2 |& [ | |& |8 |2 |& |% |2 |&
DANGER®
WARNING -
CAUTION
NOTICE
IMPORTANT
a damage to product or product environment

considerable impairment to operation
this danger class is not required for MAGIC ISDN Telephone Hybrid

The signal word "Note” is also used in the Operator Manual. Text passages
marked in this way do not describe a danger, but rather contain reminders,
tips and general information to ensure optimum operation of the system.

Symbols

The following symbols are used:

TAB. 2 WARNING SYMBOL

Symbol common usage

General warning about a danger

Important advice




TAB. 2 WARNING SYMBOL

Symbol common usage

Warning about a dangerous electrical voltage

The safety instructions classified as ,danger”, ,warning” and ,caution” al-
ways include a warning symbol. ,Notice” and ,important” safety instruc-
tions sometimes include a warning symbol.
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Construction

CONSTRUCTION

The functions of the MAGIC ISDN Telephone Hybrid are included in a single
unit. The system has a 19" rack (1 HE).

The system can be expanded with the AES/EBU/Analogue Module when re-
quired. This module provides two additional analogue inputs/outputs as
well as two digital inputs/outputs (physically: one digital AES/EBU inter-
face).

FIG.1 FRONT VIEW: MAGIC ISDN TELEPHONE HYBRID

(- Audio (@D

® MAGIC I1SpbN TELEPHONE HYBRID Mnﬁ?‘ow“ ®

HANDSET
POWER CONNECT ALARM

® = O &= ®

O vadeinGermany ()
Control LEDs Handset socket
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2.1

System Description

SYSTEM DESCRIPTION

The block diagram of the system is shown in Fig. 2.

FIG. 2 THE BLOCK DIAGRAM OF THE MAGIC ISDN TELEPHONE HYBRID
Line-
RS232C < p| basic-construction interfaces
TTL USERI/O 2xS,
HSD (Relay) ISDN Module 4+
LSD (Keypad) <« 4
: AES/EBU f *
Linel p ANALOGUE
AES/EBU  Line 2 =] Module DsP
< > @— - Echo Canceller
Line 1 ~ -N-1, AGC Standard
Anal Tine 2 - Digital mixing Aand'aor
nalogue : udio-
< > (Gptional) + interfaces
Audio codec >
- Analogue Audio T < Handset
- G.711 Codec
|

Audio (CMD) *

Functionality

Via the Telephone Hybrid system three or four callers pre selected can go On
Air simultaneously. Additionally there is a call forwarding function to fixed
numbers. The signal receivedby the caller can either be from the analogue au-
dio interface or from the handset. The caller’s signal is always available at the
handset or and simultaneously at the audio-interface.

For each of the maximum of four callers, a digital Echo Canceller is available.
This Echo Canceller is necessary to suppress disturbing echo when normal
analogue telephones are used by the caller.

Likewise, the Automatic Gain Control (AGC) can be turned on for each caller.

To suppress disturbing noise of callers who are currently not speaking, the
Expander can be activated.

In the conference mode there is the possibility of mixing all callers digitally
and connecting the mixed signal to one interface. The callers get the digitally
generated Mix Minus signal.

Three relays (HSD interface) are available for external signalling. The follow-
ing conditions can be displayed:

— atleast one caller is ON AIR
— atleast one caller is in PRE TALK
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System Description
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— atleast one B-Channel has an incoming call

The configuration is realised by the included Windows Software. Control can
also be carried out by this software. In parallel to the operating software the
MAGIC Hybrid Keypad can be connected as an option. This keypad with an
illuminated display, makes easy operation of the system possible. The record-
ing level for each caller shown on the display, provides immediate informa-
tion about the volume of the incoming signals.

An optional AES/EBU/Analogue Module is available which expands the sys-
tem by two further analogue or two digital AES/EBU inputs/outputs (swit-
chable). Then for example, the PRE TALK and ON AIR functions can be used
simultaneously.



3.1

NOTICE

3.2

WARNING

Putting the system into operation

PUTTING THE SYSTEM INTO OPERATION

Mounting

With its dimensions (W x H x D) of 439 mm x 44,5 mm (1 HE) x 300 mm the
MAGIC ISDN Telephone Hybrid can be operated as a table-top device or be
inserted into 19" racks. Additionally, mounting brackets are provided for the
installation into an ETSI rack.

During the installation care should be taken to ensure that the bending radius
of the cables is always greater than the minimum allowed value.

If the MAGIC ISDN Telephone Hybrid is installed in a rack, it should be en-
sured that sufficient ventilation is provided. It is recommended that approx.
3 cm clearance is left next to the openings. As a rule, the ambient temperature
of the system should not lie outside the range +5°C to +40°C. These limits are
of particular importance if the system is inserted in a rack.

During operation, the humidity must lie between 5% and 85%.

Incorrect ambient temperature and humidity can lead to equipment fail-
ure.
Operation of the unit outside the above limits invalidates the warranty.

The operation of the system must therefore lie within the specified limits.

Connection to the mains supply

The system can be operated with a system voltage between 90 V and 253 V
and a mains frequency between 45 Hz and 65 Hz. The power consumption
has a maximum value of approximately 35 W. In accordance with safety reg-
ulations, the housing must be earthed (grounded). This earthing is usually re-
alised via the protective (earth or ground) conductor of the mains cable. If the
mains cable does not have a protective conductor, however, the device must
be earthed via the earthing bolt.

Dangerous voltage in case of wrong earthing!
If the earthing is defective or lacking, hazardous voltages can be present on
the housing in the event of a fault.

Do not use extension cable without an earthing contact!
In case of doubt provide additional earthing!

After switching the system on, the green POWER LED should light up. An in-
ternal reset is then triggered. When the ALARM LED stops blinking the sys-
tem is ready for operation (approx. 45 seconds).
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Putting the system into

3.3

3.4

3.5

WARNING

PAGE 20

operation

Alarm indication LEDs

The MAGIC ISDN Telephone Hybrid has three LEDs for signalling.

(1) POWER green
Lights up when system is ready for operation (only +5V).

(2) CONNECT green
Lights up if at least one telephone connection is established.

(3) ALARM red
Lights up if a fault has occurred in the unit. The Windows PC software
provides more detailed information about the error (see page 25).

Controls on the front side

The system has no controls on the front side; there is only a socket for the
handset (not included in the delivery).

Changing the fuse

The mains system is protected with help of a fuse, which is soldered into the
power supply. Only expert personnel are allowed to change the fuse.

Dangerous voltage when the equipment is opened!
The unit should only be repaired by experienced technicians or our expert
personnel.




Putting the system into operation

3.6 Connecting the system

The following diagram shows how the system is connected.

If an AES/EBU/Analogue Module is equipped, the audio interfaces can be con-

figured by the user.
FIG. 3 CONNECTING THE SYSTEM WITHOUT AES/EBU/ANALOGUE MOD-
ULE

2o
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FIG. 4 CONNECTING THE SYSTEM WITH AES/EBU/ANALOGUE MODULE
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Putting the system into operation

FIG.5 CONNECTING THE SYSTEM IN ALTERNATIVE LINE MODE
PC with Digital Analogue
Software
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ON AIR Line 1
ON AIR Line 2
ON AIR Line 1
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FIG. 6 CONNECTING OF MASTER AND SLAVE SYSTEMS
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4.1

4.2

Windows PC Software

WINDOWS PC SOFTWARE

The configuration of the system is done by the Windows PC software in-
cluded in the delivery.

Hardware requirements

The PC must fulfil the following minimum requirements:

- IBM PC AT, IBM PS/2 or 100% compatible

— Pentium Processor (> 133 MHz) recommended

— Windows 95B/98/ME/2000/XP operating system
— approx. 600-kByte available conventional memory
— 2-MB available hard disk memory

— screen resolution of 800 x 600 pixels

— atleast one available RS-232 serial interface

— Microsoft, IBM PS/2 or 100% software compatible mouse

Connection to the PC

Place the included disk in the disk drive and press the START button on Win-
dows 95B/98/ME/2000. Select the sub menu item Run...and insert into the
command line

<drive name:>setup.exe
(e.g. A:setup.exe).
Follow the instructions of the installation program.

Start the software after the installation, by clicking the TELEPHONE HY-
BRID symbol.

Connect the PC via a null modem cable (pin 2 and pin 3 are crossed, pin 5 =
GND) with the system.

Turn the system on.

The red blinking ALARM LED signals that the system is booting. After ap-
prox. 45 seconds the LED stops blinking. The system is ready for operation.
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Windows
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PC Software

4.3

4.4

Operation of the system

The MAGIC ISDN Telephone Hybrid can either be operated with the simple
windows PC software in a slightly limited way or it can be operated with the
more user friendly MAGIC Hybrid Keypad option. Which operation is used
depends on the type of application.

Control elements of the windows PC software

After starting the software the main menu of the MAGIC ISDN Telephone Hy-
brid application is displayed.

FIG.7 MAIN MENU OF THE OPERATING SOFTWARE

EX MAGIC ISDN Telephone Hybrid
File Configuation Admiristiation Help

DROP DROP DROP DROP

The number is entered by the J J keys. Alternatively, the keypad of
the PC can also be used.

Key _J deletes the complete entry, key J deletes only the last character of
the entry.

These six | keys represent the programmable quick dial numbers that
can be programmed by the system configuration (see CHAPTER 4.9.2.6, page
49).

8 keys show the respective mode of the four B channels:
The j key establishes a connection.

An existing connection is represented by @ .

If there is an incoming call, a message appears on the display. Now the call
can be accepted or rejected.

With the J key a connection can be dropped.



NOTE

Windows PC Software

If the optional handset is available, it is possible to talk to the caller via this
handset. The switchover is made by the _J key (handset activated) or by the
n key (audio input activated).

Please note that the callers signal is also audible on the audio output and on
the handset simultaneously. The switch operates only on the input.
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PC Software

4.5

ATTENTION

Menu Configuration -> COM-Port

To enable the system to be configured the serial connection between the PC
and the system has to be established.

In case of a faulty connection between PC and system the following error mes-
sage appears after a short time:

FIG.8 ERROR MESSAGE WHEN COMMUNICATION IS INTERRUPTED

No connection to
MAGIC ISDN Telephone Hybrid !

Please check the COM Port
and/or
the RS232 cable.

To rectify the fault, the correct interface has to be chosen.
From the configuration menu select the COM Port sub menu.
Set the Port on your PC to which the system is connected . After pressing the

OK button, the error message should disappear. If the message does not dis-
appear check the cable.

Windows NT4.0/2000
Only an ,,Administrator” is able to set the COM Ports when using Windows
NT. Otherwise, the setting can be changed but it will not be stored.

For configuration always log on as an Administrator.

FIG. 9 SETTING OF RS232 PARAMETERS

Fart :

Baud: |192DD 'l

Data Bits : IS 'l
Farity : INone 'l
Stop Bits : I‘I 'l

MT user will only be able to change
theze parameters if they are logged
in with ADMINISTRATOR rights !

Cancel | ()8 I




4.6

Windows

PC Software

Menu File -> Exit

Choosing File -> Exit, exists the application.
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PC Software

4.7

4.7.1

ATTENTION

4.7.2

ATTENTION

NOTE

Menu Administration

Submenu System Panel

Clicking Administration -> System Panel opens the System Panel. This is
only for service purposes. Entries should only be made here by a technician.

Faulty entries can lead to a system failure.

Only insert commands when asked to do so.

FIG. 10 SYSTEM PANEL

System Panel

WZ.32Z 11.03.02 14:42 HYBRIDI(G.7Z5-HW)

[ver Send I Close |

Submenu Software Download

With Administration -> Software Download open the window to load new
Firmware on the system.

New software downloaded, for example, from our internet website always
includes the Windows PC Software and the Firmware for the System.

When making an update both the PC Software and the Firmware must be up-
dated.

The latest software can be found on
http:llwww.avt-nbg.de

Then switch to Service and Software Registration.

The software has the Ident.No. 430144




Windows PC Software

FIG.11 SOFTWARE DOWNLOAD

Download of the IFE Software
Iife_hybr Browse |

Eance! |

CRC Errars : I

Frogram :

|
Data: |
|

Eprom :

Cloze |

To download new firmware, choose the file IFE_HYBR with help of the
Browse button.Then press the Start button to start the download. This proce-
dure takes approximately 5 min. Afterwards, a reset of the system is done.
Close the window with the Close button. After booting the system, the new
functions are available.
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Windows PC Software

4.8 Menu Help -> About Telephone Hybrid

Selecting Menu -> About Telephone Hybrid displays the information on the
software and firmware versions.

For questions or remarks, the contact address is also shown.

The OK button closes the window.

FIG. 12 ABOUT TELEPHONE HYBRID

Audio
Video
Technologies

MAGIC ISDN Telephone Hybrid PC Yersion 2.32
Firmware Version 2.32
ISDN Firmware Version 1.80

Copyright 2002

A¥T Audio Yideo Technologies GmbH
Rathsbergstrage 17
D-90411 Nurnberg

Tel.: 0911 5271 0
Fax: 0911 5271 100
Internet: www_avt-nbg.de

cfio & Video ovar networks
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4.9

Windows PC Software

Menu Configuration -> System

With the Configuration -> System menu an experienced user is able to set the
configuration via the Standard submenu. Each tab is selectable.

For inexperienced users, configuration with the help of the Wizard is recom-
mended since it shows the configuration step by step.

The following configuration description is divided into
- without MAGIC Hybrid Keypad
and
- with MAGIC Hybrid Keypad,
since there are significant differences when operating the system.
See CHAPTER 4.9.1. for more about the use without keypad.

When using a keypad (and additional PC Software) see CHAPTER 4.9.2.
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PC Software

4.9.1

4.9.1.1

NOTE

NOTE

NOTE

System configuration without keypad
Clicking Configuration -> System opnes system configuration window.

The configurations are summarized under different tabs. They are described
in detail for use without the keypad.

General Settings

FIG. 13 GENERAL SETTINGS

System Configuration B
Signal Processing | Audio Line Settings I Quick Dial Settings I
General Settings | MSH Settings I Audio Level Settings

B |
General

™ Keypad available
™ Use Individual ON &IR Lines Mods

50 Protocal : IEDSS‘I 'l
Mumber of max. Incoming Calls : |4 [1..4]

™ Auto Angwer Call

Inzoming Call Signalling [Relay 1 Behaviour): | System controlled | =

™ Enable System Buzzer

Cancel |

Keypad available

When using the MAGIC without the Hybrid Keypad this option must not be
set. This setting provides further functionalities as well as assignment of au-
dio interfaces.

The audio interface assignment table without keypad can be found in
CHAPTER Al, page 57.

Use Individual ON AIR Lines Mode

This function is only relevant for systems equipped with AES/EBU Analogue
Modules (see Fig. 5, page 22)

With this option the hybrid can be switched to individual mode. All callers
are then routed to their own audio interface. Now the hybrid can be used as
triple ISDN Telephone Hybrid.

The audio interface assignment table for this configuration can be found in
CHAPTER Al, page 57.

S Protocol

Choose the correct Sy protocol. In most cases it is the EDSS1 (Euro ISDN).



NOTE

Windows PC Software

In some cases in a PABX, the old 1TR6 German national protocol can be
found.

Number of max. Incoming Calls

The MAGIC ISDN Telephone Hybrid has a maximum of four B channels that
can be called simultaneously. This equipment permits a telephone conference
with four participants.

When a single Sy line is connected, enter 2 here. If the second S line is also
connected, enter 4. To prevent more than one caller dialling in simultaneously
a 1 must be entered.

If the individual mode is set, a maximum of 3 callers can dial in simulta-
neously.

Auto Answer Call

If there is an incoming call, the system can accept the call automatically. For
this, set the appropriate check mark.

To prevent calls being auto answered do not set the check mark.

In the case of an incoming call, a relevant message appears on the PC.

Incoming Call Signalling (Relay 1 Behaviour)

The system has three relays one of which is used for external call signalling
(Relay 1, see CHAPTER A2.5).

The combination field permits the following settings:

— always open: The relay is always open.
— always closed: The relay is always closed.

— System controlled: If there is an incoming call on any channel the relay is
closed.

Enable System Buzzer

Incorrect operations or cautions can be signalled in the system by a buzzer. To
turn on the warning signal, set the appropriate check mark.
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PC Software

4.9.1.2

ATTENTION

NOTE

MSN Settings (Multiple Subscriber Number)

MSN usage
MSN is used for addressing a particular unit on the ISDN Bus, which allows
the operation of up to 8 units in parallel.

If only one unit is connected the entry of MSN is normally not necessary.

FIG. 14 SYSTEM CONFIGURATION TAP MSN SETTINGS
System Configuration B

HOLD Signal Recording / Source | Signal Processing I Quick Dial Settings I

General Settings MSN Settings Audio Level Settings
M aster |
MSN-1 MSN-2
501: | |
502: | |

USER [0 Interface: Fin1 and Pin S open  -» MSM-1 active
Fin1 and Pin G closed > MSH-2 active

Cancel |

If an MSN has to be used, enter it in the MSN-1 field. Per Sy connection, two
MSNs can be entered.

With MSN the B channel of an ISDN connection cannot be addressed.

Use of the field MSN-2 is intended for a redundant system. For security as-
pects many radio stations have a second studio that is completely identical to
the first one. In case of a fault, calls can be switched immediately to the second
studio. In general the switching to another ISDN number is quite difficult, but
the Hybrid offers the possibility of choosing another MSN via a TTL operating

signal.

For this, in principal two Hybrids are operated on the same ISDN Bus. There-
fore without an MSN entry, both Hybrids would signal one caller. To always
make sure that only one Hybrid is active, both systems must have a vaild
number in MSN-1. In MSN-2 in both systems, enter an invalid number (e.g.
1111111). On both systems, connect pins 1 and 5 of the USER IO interface as
shown in Fig. 15. When switching over, one system now gets the valid MSN-1
block and the other one gets the invalid MSN-2 block. Thus always, only one
system is active.



Windows

PC Software

FIG. 15 REDUNDANT OPERATION VIA MSN-BLOCK SWITCHING

ISDN BUS

Pin 1 and 5 open: active

Pin 1 and 5 closed: inactive

TAB.3 EXAMPLE FOR MSN-ENTRIES (VALID FOR BOTH SYSTEMS)
MSN-1 MSN-2
Sp1 5271189 1111111
5271189 1111111
Sp 2 5271219 1111111
5271219 1111111
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PC Software

4.9.1.3

NOTE

Audio Level Settings

The nominal level of the system can be set separately for the input, Level In as
well as for the output, Level Out.

One of the following values can be set as the nominal level.
0 dBu, 3 dBu, 6 dBu, 9 dBu

The head room is always 6 dB so that, with a nominal level of 9 dBu a maxi-
mum level of 15 dBu can be achieved.

If the nominal Level In level is raised at the input, the level at the receiver will
be correspondingly lowered.

FIG. 16 SETTING OF THE AUDIO LEVEL

System Configuration




Windows PC Software

4.9.1.4 Quick Dial Settings

In the Stored on PC panel up to six different quick dial keys can be pro-
grammed. These quick dial keys are shown in the main menu of the user in-
terface. Insert the corresponding name in the Name field against the number
entered in the Number field.

FIG.17 CONFIGURATION OF THE QUICK DIALS

System Configuration
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PC Software

4.9.1.5

NOTE

NOTE

Audio Line Settings

Under Audio Line Settings, the audio interfaces of the system can be config-
ured.

See CHAPTER Al, page 57 for the table of the audio interface assignment for
different modes.

FIG. 18 CONFIGURATION OF THE AUDIO INTERFACES WITHOUT MODULE
System Configuration B
General Settings | MSH Settings | Audio Level Settings I
Signal Processing Audio Line Settings | Quick Dial Settings
—&AES/EBUAnalogue Module

Clock Source of Digital Hutput IHecovered Clock [ from digital audio input | j

System | Audio Input

Edit |

—Audio [nput/Output Interface Assignment

Audio Interface | Aszsignment 1 | Aszsignment 2 |
Analogue Audio Master OM AIR not used

Default Settings | Edit |

Cancel |

If the AES/EBU/Analogue Module is not fitted, the system has only one ana-
logue audio interface. The caller’s On Air signal is stored under Assignment 1.

In addition when it is desired to use the optional handset on the same inter-
face, the Pre Talk function can be selected under Assignment 2.

The system has three relays. One of these relays is used for signalling the Pre
Talk mode (see CHAPTER A2.5, table 13). The mixer can be connected via this
relay.

If the AES/EBU/Analogue Module is not fitted in the system, no further set-
tings can be made.

When the optional AES/EBU/Analogue Module (CHAPTER A2.7.1, page 65)
is fitted, the system is expanded to two analogue or two digital AES/EBU au-
dio inputs/outputs. In general these inputs and outputs can be configured as
desired.
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FIG. 19 CONFIGURATION OF THE AUDIO INTERFACES WITH MODULE
System Configuration B
General Settings | MSH Settings | Audio Level Settings I
Signal Processing Audio Line Settings | Quick Dial Settings
—&AES/EBUAnalogue Module

Clack Source of Digital Dutput IHecovered Clock [ from digital audio input | j

System | Audio Input
b aster analogue

Edit |

—Audio [nput/Output Interface Assignment

Audio Interface | Aszsighment |
Analogue Audio Master not used
AES/EBU Analogue Module Master Left OM AIR
AES/EBU Analogue Module Master Right not used

Default Settings | Edit |

Cancel |

When using the digital AES/EBU outputs the clock which drives these inter-
faces should be set under Clock Source of Digital Output. The following set-
tings are possible:

— Recovered Clock (from digital audio input)

This setting can only be used when the digital input is connected to a dig-
ital source. The digital output signal is then synchronised to the digital in-

put signal.

— Internal Clock

The clock for the release of the digital output signal is generated internally.
In this case the sampling rate is always 48-kHz.

— External Clock

With this setting the clock, which the digital output signa is fed, must be
fed in via the BNC-socket. The sampling rate must be 48-kHz. The relevant
»~word” clock is available by the BNC-socket as an output.

Select the system Master and press the Edit key to choose the analogue input
audio-interfaces. Set analogue in the displayed panel.

Thus three analogue inputs ( the already existing audio interface of the system
+ two other interfaces on the module) and three analogue audio outputs are
available. The two analogue outputs on the module are additionally imple-
mented in parallel on the digital output interfaces of the module. Set the clock
source in Clock Source of Digital Output to Internal Clock.

The digital' inputs of the module are chosen by selecting the system Master,
pressing the Edit key and then setting digital, there are one analogue and two
digital audio inputs available. Additionally the system has two digital and
one analogue output. The digital outputs of the module are also implemented
in parallel on the analogue audio interfaces of the modules. The digital in- as

1 Please note that physically this is only one AES/EBU interface.
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well as the output does have its own sample rate converter. Set as clock source
in Clock Source of Digital Output one of the above mentioned operating
modes (see page 39).

Audio Input/Output Interface Assignment

With this setting the function of each audio interface in the system is defined.

See CHAPTER A1, page 57 for the audio interface assignment table for differ-
ent modes.

The assignment of the function always refers to the input and output.
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Signal Processing

In this dialogue, the handling of incoming telephone signals can be config-
ured.

FIG. 20 CONFIGURATION OF THE SIGNAL PROCESSING
System Configuration B
General Settings I MSH Settings I Audio Level Settings I
HOLD Signal Recording / Source Signal Processing | Quick Dial Settings I Audio Line Settings
— Line Setting:
Mo. | AGC | Echo Canceller |
1 off fuli}
2 off fuli}
3 off fuli}
4 off fuli}
—AGLC Setting:
Threshold : |-32 dBu [ -64 dBu ... 0dBu | I‘I.D 'l dB
Speed:
Level : I-‘IS dBu [ -64 dBu ... 0dBu | 100 =) ms
~ ¥ Expander
Threshold : |-32 dBu[-63 dBu ... -10dBu
ol

AGC (Automatic Gain Control)

For each of the four channels, the Automatic Gain Control can be turned on
(AGC) seperately.

Double click with the mouse on the appropriate channel to open the configu-
ration window. To turn AGC off, choose Off, to turn it on, select On.

Use of AGC
AGC is always useful for setting the correct level when it is not possible to
talk to the caller in advance.

But: AGC is no wizard! There is no way that the volume of quiet callers can
be turned up or the volume of very loud callers can be turned down.

AGC Settings

The correct functioning of the AGCs can be optimized using different param-
eters.

— Threshold: The AGC only becomes active when the signal has exceeded
the limit of the set value. The default setting is -32 dBu.

— Level: This setlevel meets the average expected level. Please allow enough
space for head room. The default setting is -18 dBu.

— Speed : depending on how the AGC should re-adjust the level - slow or
very fast- the setting for the speed can be made in this field. The faster the
AGC is, the clearer the level steps can be heard. If the AGC is too slow, in
general the caller is either too quiet or too loud. The default setting is
1dB/100ms.
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Echo Canceller
An Echo Canceller can be turned on or off for each channel.
Double click with the mouse on the appropriate channel to open the configu-

ration window. To turn the Echo Canceller off, choose Off, to turn the echo-
canceller on, select On.

Use of the Echo-Canceller

In general the use of the Echo Canceller is recommended. Always when a
caller with an analogue telephone calls to the Hybrid there is an echo on the
channel, which can interfere with the received signal. Digital telephones (e.g.
ISDN or mobiles) do not cause this kind of echo. In this case, an Echo Cancel-
ler probably impairs the incoming signal. For this reason when establishing
the connection the Hybrid sends a short test signal to the caller and measures
the level of the echo. If the set value is not exceeded the Echo Canceller will
be turned off since it is expected that the caller is using a digital telephone. If
the level of the Echo is too high the Echo-Canceller turns on automatically.

However, each Echo Canceller can only cancel echoes if the signal delay lies
within a certain range. Telephone connections via satellite have such a high
range of delay that the Echo Canceller may not operate correctly.

Expander

The Expander adjusts a caller’s signal automatically to a lower level when a
certain threshold is reached. With this devise the background noise of callers
who are not actually speaking, is completely filtered.

The Expander is turned on by setting the check mark. The threshold at which
the noise suppression should start is defined in Threshold. The default setting
is -32 dBu.
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System Configuration with Keypad

The configurations are summarised under different tabs which are now de-
scribed in detail for the operation of the Hybrid with Keypad.

General Settings
When using the MAGIC Hybrid Keypad there are two different displays pos-

sible depending on the configuration of the General Settings tab. These set-
tings depend on the configuration of Use Individual ON AIR Lines Mode.

FIG. 21 SYSTEM CONFIGURATION TAB GENERAL SETTINGS

System Configuration

HOLD =
System controlled |—

riif LD o FRE

Keypad available

To use the MAGIC Hybrid Keypad this option must be set. This setting effects
other functionalities as well as the assignments of the audio interfaces.

PAGE 43



Windows

PAGE 44

PC Software

NOTE

NOTE

NOTE

NOTE

Additionally, when the keypad is active, the choice of using the standard op-
erating mode is also available. The standard mode is automatically set up af-
ter turning on the system. The following modes can be chosen:

— Standard Mode: if this setting is selected, only one of the caller is On Air.
All other callers hear the Hold Signal. On the display of the MAGIC Hybrid
Keypad the message Standard is shown.

— Conference Mode: all callers are automatically mixed in a conference and
are On Air simultaneously. On the display of the MAGIC Hybrid Keypad
the message Conference is displayed.

— Next Mode: the callers are automatically put on Hold. By pressing the Next
key on the MAGIC Hybrid Keypad, the first caller is put On Air. Pressing
this key once again drops this connection and the next caller is put On Air,
and so on. The MAGIC Hybrid Keypad shows Next on the display.

The table of audio interface assignments with the keypad can be found in
CHAPTER Al, page 57.

Use Individual On Air Lines Mode

This function is only relevant for systems equipped with AES/EBU/Analogue
Modules.

This option activates the Individual Mode of the Hybrid. All callers are routed
to their individual audio interfaces. With this function, the Hybrid can be
used as a triple ISDN Telephone Hybrid.

Enable Pre Talk
When the Individual Mode is turned on, there is additionally the possibility

to activate the Pre Talk operating mode. Please note that the Pre Talk mode
also needs an audio interface.

The table of audio interface assignments with this configuration can be found
in CHAPTER Al, page 57.

S Protocol
Select here the desired Sg Protocol. In most cases it is EDSS1 (Euro ISDN).

Sometimes the old German national 1TR6 protocol can be found in PABXs.

Number of max. Incoming Calls

The MAGIC ISDN Telephone Hybrid has a maximum of four B channels into
which callers can dial in simultaneously. Therefore a telephone conference
with up to four participants can be accomplished very easily.

Enter 2 when only one S line is connected. Enter 4 when a second S Line is
connected. To prevent several callers calling in simultaneously, the value
must be set to 1.

If the individual mode is activated, a maximum of 3 callers can dial into the
system simultaneously.




NOTE

Windows PC Software

Auto Answer Call

Incoming calls can be accepted by the system automatically. Set the relevant
check mark.

To prevent auto calls being answered automatically, leave the box unchecked.
If there is an incoming call the relevant message is displayed on the PC.
If the individual mode is not configured another combination field appears.

In this field it can be defined to which line the caller should be routed. The se-
lection depends on the audio interfaces available.

Incoming Call Signalling (Relay 1 Behaviour)

The system has three relays. One relay is used for external call signalling (see
A2.5, page 64).

The combination field allows the following settings:

— always open: the relay is always open
— always closed: the relay is always closed

— System controlled: if there is an incoming call on any channel the relay is
closed

Enable System Buzzer
Faulty operations or warning signals can be signalled in the system by a

buzzer. To enable this system buzzer set the relevant check mark.

Mix caller in HOLD to PRE TALK output

This function is only available for systems equipped with AES/EBU/Ana-
logue Modules. Additionally, a Hold Line must be configured.

If this function is activated the signal of callers in the Hold mode of the
MAGIC Hybrid Keypad are mixed with the signal of the caller in Pre Talk.
These callers do not hear the outgoing Pre Talk signal. The purpose of this
function is so that callers in Hold can immediately attract attention.

Call Forwarding

The system supports call forwarding. The Program Presenter only has to
press one button on the MAGIC Hybrid Keypad to forward the call to the ed-
itorial department. This is quite useful for example, after a game show when
the address of the caller is to be written down. To be independent from ISDN
installations, the call forwarding is made to a B-channel on the system. The
caller is still kept in the system. Thus the Program Presenter has the possibility
get the caller back.

Number of line used for Call Forwarding

The last B channel of the last Sy line should always be entered here. For one Sy
line, enter B channel 2, for two Sg lines, enter B channel 4.
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4.9.2.2

4.9.2.3

4.9.2.4

4.9.2.5

Call Forwarding number

When the call is to be automatically forwarded to a pre determined number,
enter this number in this field. If the field is left blank any number can be di-
alled.

PRE TALK relay

The system has three relays. One relay is used for signalling the Pre Talk
mode (see CHAPTER A2.5, Relay 1). As soon as a caller is in Pre Talk, the re-
lay activates. For example, an automatic switch over to the mixer can take
place via this relay.

PRE TALK signalling combined with PRE TALK source

This function serves to activate the Pre Talk relay only when Pre Talk in ad-
dition to the audio input n and not the telephone handset ’J are used as
the source.

MSN Settings (Multiple Subscriber Number)

Refer to CHAPTER 4.9.1.2, page 34

Audio Level Settings

Refer to CHAPTER 4.9.1.3, page 36

Signal Processing

Refer to CHAPTER 4.9.1.6, page 41

Audio Line Settings

Refer toCHAPTER 4.9.1.5, page 38
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4.9.2.6 Quick Dial Settings

Depending on the mode of operation several quick dial keys can be pro-

grammed.
FIG. 22 CONFIGURATION OF QUICK DIALS
System Configuration B
General Settings I MSH Settings | Audio Level Settings I Signal Processing I
Audio Line Settings Quick Dial Settings | HOLD Signal Recording / 5ource
— Stored on PC
Quick Dial ~ Name Mumber
1: IHedaktion |1 0
2 I I
& I I
4 I I
53 I I

E: I

— Stored on Hybrid

Quick Dial Mumber Audia Line
ot [130 |PRETaLK =]
w2 | |HoLD =
wz | |HoLD Jd|

Cancel |

With Stored on PC, up to six different quick dial numbers can be pro-
grammed. The quick dial numbers are displayed on the main panel of the user
interface. Enter in the Name field, a clear description for the number, which
must be entered in the Number field.

If the optional MAGIC Hybrid Keypad is also available, three additional quick
dial numbers for the keys QD 1... QD 3 can be stored. Enter the desired num-
bers in the Number field. The Audio Line! selection allows the automatic as-
signment of the caller to a particular audio line as soon as the call is answered.
The possible audio lines depend on the configuration of the system.

1 The system has different internal logical audio-lines like e.g. Pre Talk, On Air, Hold etc. The logical audio-lines can
be routed in any way to the physical audio interfaces.
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4.9.2.6.1

Hold Signal Recording/Source

The Hold-signal can be configured via this dialog. Apart from the normal in-
terface selection the possibility exists to store an individual signal of 8 seconds
duration in the system. This signal is given in cycles.

FIG. 23 CONFIGURATION OF THE HOLD-SIGNAL

System Configuration

General Settings | MSH Settings I

Audio Level Settings I

HOLD Signal Recording / 5 ource | Signal Processing I Quick Dial Settings I Audio Line Settings

— General Setting:

Hold Signal Source :

FPause between Repetition : IU B0

Hold Signal Length : |4.844B25 B0
— Record Signal
Fecord Source : IAnangue Audio b azter j

Start I Stop |

— Play Signal

Start | Stop |

Cancel | ()8 |

General Settings

Hold Signal Source

Specify here the source from which the Hold signal should be generated. Se-
lection can be from the audio interfaces, which are configured as On Air or
Hold (see 4.9.1.5, page 38).

However there is also the possibility of storing a particular Hold signal in the
system and to output this signal. Choose Recorded Hold Signal for this.
Pause between Repetition

When using a generated Hold signal, the pause in seconds between the repe-
titions can be defined.

Hold Signal Length

The length of the recorded Hold signal is displayed here.

Record Signal

Record Source

Select here the source for the recording of the Hold signal.
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Press the Start button to begin recording.
By pressing the Stop button recording is ended.

If the recording is acceptable it can be saved with the Save button.

Stored Hold Signal
Please note that while making an update of the firmware, the Hold signal is
erased from the system.

After every update the Hold signal must be recorded again.

Play Signal

At any time, the recorded Hold signal can be listened to before it is saved by
pressing Save.

With the Start button, the signal is present on all audio outputs.

The Stop button stops the replay.
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OPTION: MAGIC HYBRID KEYPAD

The optional MAGIC Hybrid Keypad supports a comfortable operation of the
system for users who do not want to use a PC to control the Hybrid. However,
it is possible to use a PC and the keypad in parallel as a redundancy on the
system. The maximum number of incoming calls which can be displayed, is
limited to four calls at the MAGIC Hybrid Keypad 4, to seven calls at the
MAGIC Hybrid Keypad 7 and 12 calls at the MAGIC Hybrid Keypad 12.

The MAGIC Hybrid Keypad requires its own power supply and the delivery
includes a special adapter cable (see A2.4, page 64) to connect the MAGIC
Hybrid Keypad to the MAGIC ISDN Telephone Hybrid and to the power sup-

ply.

Connect the 9-pin, SUB-D plug on the adapter cable to the 9-pin SUB-D LSD
socket on the MAGIC ISDN Telephone Hybrid. Plug the 8 pin mini DIN plug
on the the adapter cable into the 8 pin mini DIN socket on the right rear of the
MAGIC Hybrid Keypad. Connect the PS-2 plug on the adapter cable into the
PS-2 socket on the cable of the mains power supply unit. Finally plug the
mains unit into the 230V AC mains. If everything is setup correctly the display
lights up. After the system ! has been turned on and it has been booted the fol-
lowing graphic can be seen on the display:

The following figure shows the control elements of the keypad.

FIG. 24 KEY ASSIGNMENT ON THE MAGIC HYBRID KEYPAD

PreTalk — |

Hold Call

ON AIR

Disconnect Call

Call Forwarding

—DROP

%Operaﬁng Mode

%Quick Dial

Next Call

___ Blocking of
Incoming Calls

—__Switch
Handset/Analog

Global

Dlll):l I)Il()l: Drop

74
i

____ Make a call
Call Redial

Audio
Video
Technologies

!

Cancel Number Cancel last character

1 If the system was already turned on, press once either the ,C” or the ,AC” key.
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MAGIC Hybrid Keypad

Working with the MAGIC Hybrid Keypad

Before operating the MAGIC Hybrid Keypad, the configurations described in
chapter 4.4 first have to be properly set.

LCD-Display

General information about the current connection status and the available B
channels is shown in the first line the 2 x 20 character LCD Display. The fol-
lowing displays are possible:
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TAB. 4 INDICATION OVERVIEW OF THE FIRST LINE OF THE DISPLAY
Display Meaning

>>>> sent calls

% % % % incoming calls

R, no connection

AR caller is on air
HoLD caller is in hold

PRE caller is in pre talk

e D> caller is being forwarded
< ewa forwarding connection
LN ] caller is on audio line 1
I'N 2 caller is on audio line 2
LN 3 caller is on audio line 3
I'N Y caller is on audio line 4
PPPP undefined condition

The second line changes its function according to the mode.

The last character of the second line always shows the status of the Pre Talk
interface. This interface can be used either with the optional handset (display
H) or with the analogue/digital (display A) XLR input. The switching of the

Pre Talk source is made with this key ...
ANALOG

- If there is no connection, the configuration of the Hybrid is displayed.
The following operating modes are possible:
— Standard: only one caller is On Air or in Pre Talk. All other callers
are automatically in the Hold position.
— Conference: all callers in the On Air or Pre Talk modes are mixed.

— Next: the callers are automatically on Hold. By pressing the Next
key the first caller goes On Air. By pressing this key once again, the
connection with this caller will be dropped and automatically, the
next caller goes On Air.

Only when the system has the optional AES/EBU/Analogue Module Pre Talk
and On Air can be used simultaneously.




NOTE
---- HOLD ---- ----
091152171135 A

NOTE
AIR PRE HOLD ----
H B | A
>>>> PRE HOLD ---
Bl1.USER BUSY A
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— Individual: the Hybrid uses all B channels independently. The call-
ers are not mixed, they are routed to pre-configured audio inter-
faces. (see 4.9.2.5, page 46).

This operating system is only available when the Hybrid is equipped with the
AES/EBU/Analogue Module and it can only be configured through the Win-
dows PC Software (see 4.9.2.1, page 43).

— When dialling the telephone number the number dialled is displayed. The
input of the number must be made by the : _o) _y keys.

The last entered number may be cancelled by pressing key _c)
The complete input can be cancelled by pressing key A€

— Ifthereis an existing connection, the level meter is displayed. This display
has a maximum of 4 characters and 5 segments. The smallest representable
level is -34 dBu. The scale is divided into 2 dB steps. The maximum value
is +6 dBu.

— If there is a faulty connection, ISDN provides a wealth of error messages.
The meaning of the messages can be looked up in the following table. The
message on the LCD Display shows the concerned B channel in first posi-
tion followed by the error message.

TAB. 5 ISDN-ERROR MESSAGES

Error Message Description

Unass. number The number is not recognised by the ISDN. Check your input.

No route No route. When this message appears the ISDN is normally overloaded.

Dial again.

Normal disc.
User busy
No user resp.

Call rejected

Number chang.

Destin. error
Inval. number
No line avai.
No Network
Netw. failure
Congestion
Bearer capab.
Bearer serv.
Remote disc.
Procedure er.

Cannot dial

The connection was disconnected normally.

The number called is busy.

User is not responding, Possibly the wrong number was dialled.
Call was rejected. Perhaps the person called has done this.

Dialled number has been changed.

Possibly the equipment is switched off. The called end is not operational.
Invalid number.

No B channel available.

No ISDN available. Check your ISDN connection.

Temporary ISDN failure.

ISDN network error. Possibly the wrong ISDN protocol is selected.
The wanted bearer is not available.

The wanted bearer is not implemented.

Connection was disconnected by the remote end.

Distant or local ISDN-procedure error.

System cannot dial.
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5.3 Function of the keypad.

The keypad functions can be seen in the following table.

TAB. 6

KEYPAD FUNCTIONS

Key

Description

Standard operating mode: in this operating mode only one
caller is On Air, all other callers receive the Hold signal. On the
MAGIC Hybrid Keypad Standard is indicated on the dis-
play.

The operating mode can also be configured by the PC soft-
ware. (see 4.9.2.1, page 43).

Note: If the Individual mode was configured by the PC, this
key is locked.

In the On Air or Pre Talk mode all callers are automatically
mixed. Conference is displayed on the MAGIC Hybrid Key-
pad.

This operating mode can also be configured by the PC soft-
ware.
(see 4.9.2.1, page 43).

Note: If the Individual mode was configured by the PC, this
key is locked.

The callers are automatically put on Hold. By pressing the
Next key on the MAGIC Hybrid Keypad the first caller is put
On Air. Pressing this key once again disconnects the call and
the next caller is put On Air, etc. Next is displayed on the
MAGIC Hybrid Keypad.

The operating mode can also be configured by the PC soft-
ware. (see 4.9.2.1, page 43).

Note: If the Individual mode was configured by the PC, this
key is locked.

By pressing this key, the last character of an input is cancelled.
This key is also used to stop a function.

Pressing this key cancels the whole input.

The keys 0...9 are for the input of the number. The connection
is established by pressing the Call/Redial, Pre Talk, Hold or
On Air key. Pressing Call/Redial uses the next free channel. By
pressing Pre Talk, Hold, On Air, the channel can be explicitly
chosen.

The quick dial keys QD 1... QD 3 are used to call a stored num-
ber directly. The number can be stored either by the PC soft-
ware (see 4.9.2.6, page 47) or by the Keypad (see 5.4, page 55).

With the forwarding key the caller can be put through to any
previously stored or non-stored number. The programming of
this key (see 4.9.2.1, page 43) can be done either by the PC-soft-
ware (see 4.9.2.6, page 47) or by the Keypad (see 5.5, page 56).
The caller can be forwarded at any time, even when the tele-
phone is ringing.

With this key, a call to the last dialled number is set up auto-
matically on the first free channel. If the line is busy the num-

Iﬂlﬂ — ber can be redialled by pressing the key once again.
All existing connections are dropped when this key is pressed.
For confirmation the Drop all? message appears on the dis-
GLOBAL 1 ine th in th .
DROP play. By pressing the key once again the connections are

dropped.

To cancel Global Drop press C and the connections will be
retained.
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TAB. 6

KEYPAD FUNCTIONS

Key

Description

DROP

This key drops the connection. There is no pre-confirmation on
the appropriate channel.

Puts the caller in Pre Talk.

The physical audio interface is configured by the PC software.
(see 4.9.2.5, page 46)

If the optional AES/EBU/Analogue Module is not fitted, the
master audio interface will be used for Pre Talk and On Air si-
multaneously. In this case, only a changeover of the signalling
relay is made (see A2.5, page 64).

Working in the Individual mode the Pre Talk function ex-
plicitly has to be set.

Puts the caller on hold.

The physical audio interface is configured by the PC soft-
ware.(see 4.9.2.5, page 46).

The signal heard in this mode can be specified by the PC soft-
ware (see 4.9.2.6.1, page 48).

B E B

Puts the caller on On Air.

The physical audio interface is configured in the PC software.
(see 4.9.2.5, page 46).

If the optional AES/EBU/Analogue Module is not fitted, the
master audio interface will be used for Pre Talk and On Air si-
multaneously. In this case only a changeover of the signalling
relay is made (see A2.5, page 64).

This key selects the Pre Talk source. If the optional handset is
connected, it is possible to switch between the audio input and
the handset-microphone for Pre Talk. On the display H ap-
pears for handset and A for audio input.

If the optional AES/EBU/ Analogue Module is not fitted and a
digital input for Pre Talk was configured, the handset can only
be used when the analogue master audio interface of the sys-
tem was also configured for Pre Talk.

This key enables the system to be blocked for incoming calls.
Outgoing calls are still possible. Locked (blocked) appears
on the display.

When the NEXT mode is activated pressing this key puts the
next caller On Air. Pressing it once again disconnects the call
and the next caller is automatically put On Air and so on.

5.4

Programming of the quick dial keys

The quick dial keys QD 1... QD 3 can either be programmed by the PC Soft-
ware or directly by the keypad.

- ATR ----
09115271138

A

First enter the number to be programmed.

Then press any forwarding key.
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SAVE QUICKDIARL?
PRESS PRE/HOLD/RIR/C

=i Mﬂ
E¥

5.5

On the display, the question Save Quickdial? appears.

Now either Pre Talk, Hold or On Air can be pressed to get the desired mode
you want to have when the call is accepted by the called person.

To store no number press key C.

e (5 meee —oe-
09115211139 A

-

SAVE FORWARRDING NO.P
PRESS FORURRD-KEY/C

-
o
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Programming of the forwarding

The forwarding can either be programmed by the PC software or directly by
the keypad.

First enter the number to be programmed.

Then press any forwarding key.

On the display, the question Save Forwarding No.? appears.

By pressing it once again the number is saved.

To store no number press key
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Audio-Interface assignment

AUIDIO-INTERFACE ASSIGNMENT

The assignment of the audio interfaces depends on the following parameters:

- MAGIC Hybrid Keypad

— AES/EBU/Analogue Module
— Analogue or digital input

— Individual Mode

— Pre Talk

Depending on these parameters, the software configures the system automat-
ically with a useful default audio interface assignment.

If the MAGIC Hybrid Keypad and the AES/EBU/Analogue Modul are fitted
the appropriate allocation selected is that the first two channels of the keypad
are routed to the first two channels of the module.

For Pre Talk, the analogue interface of the master system is always chosen. In
case Pre Talk is to be used through the digital interface, it can be configured
by the Audio Line Settings. If additionally, the handset is to be used, Pre Talk
must be installed for both interfaces (analogue and digital) in parallel.

Yes in the config. column means that the configuration of the interfaces can
be changed.
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assignment

Al1l Assignment with an analogue input
TAB.7 AUDIO INTERFACE ASSIGNMENT: ANALOGUE INPUT
Module Individual Keypad Pre Talk Interface Assignment config.

Audio Interface Aszsignment 2
Analogue Audio Master not used

no no no no yes
Audio Interface Aszsignment 2
Analogue Audio Master FRE TALK

no no yes yes yes
Audio Interface | Aszsighment |
Analogue Audio Master not used

yes no no no AES/EBU Analogue Module Master Left OM AIR yes
AES/EBU Analogue Module Master Right not used
Audio Interface | Aszsighment |
Analogue Audio Master FRE TALK

yes no yes yes AES/EBI AAnalogue Madule Master Left 0OM AIR yes
AES/EBU Analogue Module Master Right not used
Audio Interface | Aszsighment |
Analogue Audio Master Line 3: OM AIR

yes yes no no AES/EBU Analogue Module Master Left Line 1: OM AIR no
AES/EBU Analogue Module Master Right Line 2: OM AIR
Audio Interface | Aszsighment |
Analogue Audio Master Line 3: OM AIR

yes yes yes no AES/EBUAnalogue Module Master Left Line 1: OM AIR no
AES/EBU Analogue Module Master Right Line 2: OM AIR
Audio Interface | Aszsighment |
Analogue Audio Master FRE TALK

yes yes yes yes AES/EBUAnalogue Madule Master Left Line 1: O AIR no
AES/EBU Analogue Module Master Right Line 2: OM AIR




Al2

Audio-Interface

assignment

Assignment with a digital input

To use the digital input, the AES/EBU/Analogue Module must be fitted.

TAB. 8 AUDIO-INTERFACE ASSIGNMENT: DIGITAL INPUT
Individual Keypad PreTalk Interface Assignment config.

Audio Interface Aszsighment |
Analogue Audio Master not used

no no no AES/EBU Analogue Module Master Left OM alR yes
AES/EBU Analogue Module Master Right not used
Audio Interface Aszsighment |
Analogue Audio Master FRE TALK

no yes yes AES/EBU Analogue Module Master Left 0N &R yes
AES/EBU Analogue Module Master Right FRE TALK
Audio Interface Aszsighment |
Analogue Audio Master Line 3: OM AIR

yes no no AES/EBUAnalogue Module Master Left Line 1: OM AIR no
AES/EBU Analogue Module Master Right Line 2: OM AIR
Audio Interface Aszsighment |
Analogue Audio Master Line 3: OM AIR

yes yes no AES/EBU Analogue Module Master Left Line 1: OM AIR no
AES/EBU Analogue Module Master Right Line 2: OM AIR
Audio Interface Aszsighment |
Analogue Audio Master FRE TALK

yes yes yes AES/EBUAnalogue Madule Master Left Line 1: O AIR no
AES/EBU Analogue Module Master Right Line 2: OM AIR
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A2 INTERFACES

The following figure shows the system interfaces of the Telephone Hybrid:

FIG. 25 REAR VIEW OF THE MAGIC ISDN TELEPHONE HYBRID

So 2

(@]

POWER 115/230V AES/EBU ANALOGUE
EXTENSION BUS 1

o = USERI/O RS232C LSD HSD L
= e

All interfaces are described as follows:
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A2.1

Sy Interface

This interface supports 2 B channels in ISDN networks. The system has two
ISDN interfaces for a maximum of 4 B channels.

TAB.9

PIN ASSIGNMENT: S-INTERFACE

Socket: Western (8-pole) RJ45

Pin

Signal

Electrical Characteristics

® NN G o= W N =

Not used
Not used
TXa
RXa
RXDb
TXb
Not used
Not used

Data out a
Dataina
Data inb
Data out b

Recommendation:1.430
Data Rate: B-channel: 2x64 kbit/s
D-channel: 16 kbit/s




A22

Interfaces

RS232C-Interface

The RS232C interface is used for configuring and monitoring the MAGIC
ISDN Telephone Hybrid system with a PC. To connect the system to the PC a
null modem cable, in which pin 2 and pin 3 are crossed is required. Addition-
ally, pin 5 GND, must be connected. All other pins are not essential.

TAB. 10 PIN ASSIGNMENT: RS-232-INTERFACE
Connector: R$232C (SUB-D, 9-pole, male)

A23

Pin Signal Electrical Characteristics

1 Not used Type: DTE

2 RXD Receive Data Level: V.24

3 TXD Transmit Data Data Rate: 19200 Baud

4 DTR Data terminal ready Transmission Range:max. 15 m

5 GND Ground Protocol: 1 Start bit

6 DSR Data set ready 8 Data bits

7 RTS Request to send 1 Parity bit
1 Stop bit

8 CTS Clear to send

9 Not used

TTL USER I/O Interface

External operating signals can be sent through this interface. Three signals are
always used to drive the relay within in the system.

TAB. 11 PIN ASSIGNMENT: USER I/O-INTERFACE
Connector: TTL USER-I/O (SUB-D, 9-pin, male)

Port Signal Electrical Characteristics

1 MSN switchover  input Level: TTL/CMOS
+5V: MSN-1 (level without switching) Rating;: 20 mA
GND: MSN-2

Used for relay 1
TTL 3 IN/OUT
Used for relay 2
GND

TTL 5IN/OUT
used for relay 3
TTL 7 IN/OUT
TTL 8 IN/OUT

O 0 NN U e W N
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A24 LSD (Keypad) Interface

Via the LSD interface the system can optionally be operated using the MAGIC

Hybrid Keypad.
TAB. 12 PIN ASSIGNMENT: LSD INTERFACE
Socket: LSD (SUB-D, 9-pole)
Port Signal Electrical Characteristics
1 CD Carrier Detect Level: V.24
2 RxD Receive Data
3 TxD Transmit Data Transmission Range:max. 15 m
4 DIR Data Terminal Ready
5 GND Ground
6 DSR Data Set Ready
7 RTS Request To Send
8 CTS Clear to Send
9 RI Ring Indication
A25 HSD (Relay) Interface

Three relays with floating outputs are available on this interface.

4 3 TAB. 13 PIN ASSIGNMENT: HSD (RELAY)-INTERFACE
130000000/ Socket: HSD (SUB-D, 15-pole)

Port Signal Electrical Characteristics

1 Shield max. Rating:  100mA

2 not used

3 Relay 1a signalling incoming call a

4 not used

5 Relay 2a ON AIR a

6 not used

7 Relay 3a PRETALK a

8 GND Ground

9 not used

10 Relay 1b signalling incoming call b

11 not used

12 Relay 2b ON AIR b

13 not used

14 Relay 3b PRE TALK b

15 not used
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NOTE

A2.71

NOTE

Interfaces

Audio Interface

TAB. 14 PIN ASSIGNMENT: AUDIO INTERFACE (INPUT)
Socket: input (XLR)
Port Signal Electrical Characteristics
1 Shield Input level: 0, +3, +6, +9 dBu
2 Audioin a Impedance: > 15kQ
3 Audio in b Head Room: 6 dB
TAB. 15 PIN ASSIGNMENT: AUDIO-INTERFACE (OUTPUT)
connector: output (XLR, male)
Port Signal Electrical Characteristics
1 Shield Output level: 0, +3, +6, +9 dBu
2 Audio out a Impedance: <20Q
3 Audio out b Head Room: 6 dB

Audio Interfaces on the optional AES/EBU/Analogue Module

There are two digital inputs/outputs or two additional analogue inputs/out-
puts available on the AES/EBU/Analogue Module. The configuration is
made using the Windows PC software.

The digital and analogue audio outputs on the modules are connected in par-
allel. Consequently the signal can be used on both interfaces simultaneously.

AES/EBU Audio Interface

The AES/EBU digital Audio Interface is implemented as a 9-pole SUB-D
socket. Therefore the ISDN Telephone Hybrid has two digital inputs/outputs
on one physical AES/EBU interface. Optionally an XLR adapter can be sup-
plied. The input as well as the output have their own sample rate converters.
With these, a digital source of 32, 44.1 or 48-kHz can be connected directly. For
synchronisation to an external clock (only 48-kHz) the word clock input or
output may be used.This is implemented on the adapter as a BNC socket.

TAB. 16 PIN ASSIGNMENT: AES/EBU AUDIO INTERFACE
socket: AES/EBU (SUB-D, 9-pole)

Port Signal Electrical Characteristics
AES/EBU IN a IEC958 Professional
AES/EBUIN b
GND word clock 48-kHz Word clock: TTL level 5V
AES/EBU OUT a
AES/EBU OUT b

GND AES/EBU IN
Word clock 48-kHz IN
Word clock 48-kHz OUT
GND AES/EBU OUT

O 0 N Ul e W N =

An AES/EBU Adapter Cable SUB-D, 9-pole to XLR is available (ID:490091)
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A2.7.2

goooooooog
130000000/

NOTE

A2.8

123 4

Analogue Audio Interfaces

The additional analogue audio interfaces on the module are available at a 15-
pole SUB-D socket. Optionally, an adapter cable with XLR sockets or plugs is
available.

TAB. 17 PIN ASSIGNMENT: ANALOGUE AUDIO INTERFACES
Socket: HSD (SUB-D 15-pole)

Port Signal Electrical Characteristics
1 Channel 1? INa Input:
2 Channel 1 INb Rated Level: 0, +3, +6, +9 dBu
3 Channel 2° IN a Impedance:  >15kQ
4 Channel 2> INb
5 Channel 1* OUT a Output:
6 Channel 12 OUTb Rated level: 0, +3, +6, +9 dBu
7 Channel 2> OUT a Impedance: <200
8 Channel 2° OUTb
9 GND channel 1* IN Head Room: 6 dB
10 GND
11 GND  channel 2* IN
12 GND
13 GND channel 1* OUT
14 GND
15 GND  channel 2° OUT
a On the AES/EBU audio interface, Channel 1 corresponds to the right channel
b On the AES/EBU audio interface, Channel 2 corresponds to the left channel

An Analogue Adapter Cable SUB-D, 15-pole to XLR is available (ID:490090)

Receiver

The optional handset is connected here.

TAB. 18 PIN ASSIGNMENT: RECEIVER

RI11 Socket: handset(Western 4-pole)

Port Signal Electrical Characteristics
1 Audio Outa

2 AudioIna

3 Audio Inb

4 Audio Outb




Interfaces

A29 Extension Bus (internal data bus and control bus)

The Extension Bus socket is used for the cascade connection of single MAGIC
ISDN Telephone Hybrids. This function is not used for the MAGIC Triple
ISDN Telephone Hybrid. The system can be upgraded at any time.

TAB. 19 PIN ASSIGNMENT: EXTENSION BUS-INTERFACE
@1\:.0.0.0...0.0.0.0...‘.'..]219 connector: Extension Bus (SUB-D, 25-pole, male)
Port Signal Electrical Characteristics
1 Shield Data Rate:
2 TXa Transmit Data 64kbit/s up to 2.048Mbit/s
3 Ca Control Level: V.11, symmetrical
4 RXa Receive Data Protocol for RS.485:
5 CLK48a? Clock 256x48 kHz 1 Startbit
8 Data bits
6 CLKa Clock Receive 1 Parity bit
7 1 Stop bit
8 GND Ground DataRate: 19200 Bd
9 TXb Transmit Data
10 Cb Control
11 RXb Receive Data
12 CLK48b Clock 256x48 kHz
13 CLKb Clock Receive
14 CTa Control R5485 Bus
15 CTb Control RS485 Bus
16 C_DATAa RS485 Bus
17 C_DATAb RS485 Bus
18 RXD_Va Receive_D_Valid
19 RXD_Vb Receive_D_Valid
20 TXD_Va Transmit_D_Valid
21 TXD_Vb Transmit_D_Valid
22 FSa Frame_Sync
23 FSb Frame_Sync
24 CLK48a Clock 256x48 kHz
25 CLK48b Clock 256x48 kHz
a Is only used if more than four units of a system are connected together.

PAGE 67



Interfaces

PAGE 68



A3 TECHNICAL DATA

NETWORK INTERFACES:

- 2XSO

— Protocols

Additional data interfaces

- HSD:

User interfaces

- RS232C

- USERI1/0O!

- LSD:

Coding algorithms

- G711

Audio-interface

— electronic, balanced input

— electronic, balanced output

— Nominal level
— Head room

- Impedance

1.430
DSS-1, 1TR6

3 x Relay

V.24, 19200 Bd for PC

Control signal TTL

V.24 for Keypad

Technical Data

RJ45

15-pin SUB-D,
female

9-pin SUB-D
male

9-pin SUB-D
male

9-pin SUB-D
female

3.1-kHz (telephone algorithm)

0, +3, +6, +9 dBu (can
6dB

Input:
Output:

— AGC per B Channel, configurable

XLR, female
XLR, male

be programmed)

>15kQ
<200

— Echo Canceller per B channel (128 taps, 16ms Echo cancel time)

— Expander per B channel, configurable

— Digital Mixing
- Digital Mix-Minus

POWER SUPPLY:

Alternating voltage

- 90to 253V (50/60 Hz)

1 is used to identify the hardware
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Power consumption

— max. 30 VA

MEASUREMENTS:

HxWx D

— 44 x 449 x 450 mm (1U x 19" x 450 mm)

WEIGHT:

— approx. 6 kg

ADDITIONAL INFORMATION:

EMC

— VDE 0878, limit value B

Electrical safety

— EN 60950

Temperature

+5°C to 40°C

Relative Humidity.

- 5% up to 85%
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Technical Data MAGIC Hybrid Keypad

A4 TECHNICAL DATA MAGIC HYBRID
KEYPAD
A4l Keypad
MAGIC Hybrid Keypad 4: Matrix: 8x6
43 keys
MAGIC Hybrid Keypad 7: Matrix: 8x 12
58 keys
MAGIC Hybrid Keypad 12:  Matrix: 8x12
84 keys
FIG. 26 CONNECTING CABLE- MAGIC SYSTEM KEYPAD

to the mains power supply set

=

[ —
To the MAGIC ISDN Hybrid To the Keypad

Protocol:

9600 Baud
no parity

Port MAGIC:

9-pole SUB-D connector, male

5 ASSlgnment.
6 9

Pin 2 RXD
Pin 3 TXD
Pin 5 GND (earth)
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A4.2

A4.3

PAGE 72

Power supply connector:

6-pole PS/2 connector, male

Assignment:
Pin 2: GND
Pin 5: +5V

Keypad connector:

8-pole MINI DIN connector, male

Assignment:

Pin 2: RX Data
Pin 3: GND
Pin 5: +5V

Pin 8: TX Data

LCD Display

2 x 20 characters

illuminated

Mains power supply unit:

Connector:

5V, max. 1500 mA

6-pole PS/2 connector, female

Pin Assignment:

Pin 2: GND
Pin 5: +5V



General Facts

A5 GENERAL FACTS

A5.1 Ordering numbers
MAGIC ISDN Telephone Hybrid Standard 800053

Option: AES/EBU/ANALOGUE Module 450030

MAGIC ISDN Triple Telephone Hybrid 800057
Windows PC Software Update 403144
Accessories
Handset, light grey with holder 715012
MAGIC Hybrid Headset 490087
Analogue Adapter Cable 490090
AES/EBU Adapter Cable 490091
MAGIC Hybrid Keypad 4 800054
MAGIC Hybrid Keypad 7 800058
MAGIC Hybrid Keypad 12 800056

A5.2 Included in delivery

— MAGIC ISDN Telephone Hybrid
— Windows PC Software
— Mains cable
— Self adhesive feet
— ETSI-mounting brackets
— Manual
— RS232 Control Cable

— 2x S Telephone cables

A5.3 Declaration of Conformity

The Declaration of Conformity is at the end of this description.

NOTE Please note that the MAGIC ISDN Telephone Hybrid (800053) and MAGIC
ISDN Triple Telephone Hybrid (800057) product has the hardware identifica-
tion number 229711.
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Audio
Video

Technologies
‘ €-Konformitétserkléirung
Declaration of Conformity
Name des Anbieters: AVT Audio Video Technologies GmbH
Supplier's name:
Anschrift des Anbieters: Rathsbergstrasse 17
Supplier's address D-90411 Nirnberg
erklart, daB das Produkt
declares, that the product
Produktname(n): MAGIC ISDN Telefonhybrid 229711
Product name(s): MAGIC ISDN Telephone Hybrid 229711

mit den Vorschriften folgender Europaischer Richtlinien libereinstimmt
conforms to the standards of the following European directives

Nummer/Text: EN 60950 A4 Gerétesicherheit
Number/title:

Die Ubereinstimmung wird nachgewiesen durch vollstindige Einhaltung folgender Normen:
The conformity is evidenced by strictly meeting the following standards:

Harmonisierte Europdische Normen: EN 55022/08.94, EN 50082-1/01.92

Harmonized European Standards: EN 61000-3-2/95, EN 61000-3-3/95
Ort, Datum: Nirnberg, den 10.04.01

Place, date:

Name(n): Wilfried Hecht

Name: '
Rechtsverbindliche Unterschrift(en): / Z{ /j/

Legally binding signatures: 1/ . /

Telefon: +49 911 5271-120

Phone:

Diese Erklarung beinhaltet keine Zusicherung von Eigenschaften.

This declaration includes no warranty of properties.

Die Sicherheitshinweise der mitgelieferten Produktdokumentation sind zu beachten.
The safety instructions specified in the product documentation delivered must be observed.
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